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About Us 
Hexagon Geospatial helps you make sense of the dynamically changing world. Hexagon 
Geospatial provides the software products and platforms to a large variety of customers through 
direct sales, channel partners, and Hexagon businesses, including the underlying geospatial 
technology to drive Intergraph Security, Government & Infrastructure (SG&I) industry solutions. 
Hexagon Geospatial is a division of Intergraph Corporation. 

CUSTOMERS. Globally, a wide variety of organizations rely on our products daily including 
local, state and national mapping agencies, transportation departments, defense organizations, 
engineering and utility companies and businesses serving agriculture and natural resource 
needs.  Our portfolio enables these organizations to holistically understand change and use 
information to make mission and business-critical decisions.   

TECHNOLOGY. Our priority is to deliver products and solutions that make our customers 
successful. Hexagon Geospatial is focused on developing leading-edge technology that is easily 
configurable. Through extensible, scalable and collaborative products, we enable you to 
transform multi-source content into dynamic and actionable information. We are constantly 
re-conceptualizing and improving our products. 

PARTNERS. As an organization, we are partner-focused, working alongside our channel to 
ensure we succeed together.   We provide the right tools, products and support to our business 
partners so that they may successfully deliver sophisticated solutions for their customers.  We 
recognize that we greatly extend our reach and influence by cultivating channel partner 
relationships both inside and outside of Hexagon.   

TEAM. As an employer, we recognize that the success of our business is the result of our highly 
motivated and collaborative staff.  At Hexagon Geospatial, we celebrate a diverse set of people 
and talents; and we respect people for who they are and the wealth of knowledge they bring to 
the table. We retain talent by fostering individual development and ensuring frequent 
opportunities to learn and grow.    

HEXAGON. Hexagon Geospatial plays a key role in Hexagon’s multi-industry focus, leveraging 
the entire portfolio for a wide variety of geospatial needs. Hexagon is a leading global provider of 
design, measurement and visualization technologies.  Synergistic thinking is encouraged 
across all levels and functions at Hexagon companies, so that we all respond better and faster 
to our shared customer’s needs. 

For more information, visit www.hexagongeospatial.com (http://www.hexagongeospatial.com) 
and www.hexagon.com (http://www.hexagon.com). 

http://www.hexagongeospatial.com/
http://www.hexagon.com/
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Import, Mosaic, and Reproject Tutorial 

Importing and Preparing Data for Use within Grid Analysis 

Tutorial Introduction 

The aim of this tutorial is to demonstrate a typical workflow used to combine grid layers of 
differing projections. The tutorial shows you how to import, mosaic, and reproject a set of grid 
layers with differing resolutions, datums, and elevation units. 

Topics covered in this tutorial include: 

 Opening a GeoMedia GeoWorkspace 

 Importing SDTS DEM files and aerial photographs 

 Using the Layer commands to view the import results 

 Using the Mosaic command to tile together adjoining layers and to create a single, 

continuous grid layer 

 Defining a new Study Area 

 Using the Copy/Reproject command to reproject layers into a common projection 

 

Tutorial Text Conventions 

There are several conventions used throughout the tutorial: 

 Ribbon bar items are shown as: On the Aaa tab, in the Bbb panel, click Ccc > Ddd. 

 Dialog box names, field names, and button names are depicted using Bolded Text. 

 Information to be entered, either by selecting from a list or by typing, is depicted using 
Italicized Text. 

 

Data Set 

The data set for this tutorial is in the folder C:\Grid Analysis Tutorials\Introductory 
Tutorials\Import to Mosaic to Projection. The data consists of six SDTS DEM layers and one 
digital aerial photograph of an area near Huntsville, Alabama. 

The DEM layers are referenced to Universal Transverse Mercator (UTM) projection, Zone 16 
coordinates, North American Datum of 1927 and have a resolution of 30 meters. Cell values 
give elevation in meters above sea level. The layers represent the U.S.G.S. map sheets of 
Triana, Farley, New Hope, Madison, Huntsville, and Moontown, Alabama. The data was 
produced by the U.S. Geological Survey (USGS) as part of the National Mapping Program. 

The aerial photograph of Huntsville, Alabama, is referenced to Universal Transverse Mercator 
(UTM) projection, Zone 16 coordinates, North American Datum of 1983, and has a resolution of 
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16 meters. Cell values are without units. The aerial photograph was also produced by the 
USGS. 

  The provision of U.S. Geological Survey data does not imply sanctioning by the USGS, 
and does not constitute an endorsement of Intergraph Corporation or its products. 
 

How This Tutorial Should Be Used 

This tutorial is intended for those interested in tiling DEMs, or to process layers representing the 
same area but with different resolutions, so that they can be used together in grid analysis. To 
use the tutorial effectively, you should be familiar with GeoMedia Desktop and have worked 
through the Learning to Use Grid Analysis introductory tutorial. 
 

Data Preparation 

Opening a GeoWorkspace 

Grid Analysis is completely integrated with the GeoMedia Desktop and is available when 
GeoMedia Advantage or GeoMedia Professional tiers are used. The Grid Analysis commands 
are located in the Grid tab in the ribbon bar. 

1. Launch GeoMedia Desktop, and choose Open an existing GeoWorkspace from the 
Welcome menu. 

2. Double click the More Files… option, browse to \Grid Analysis Tutorials\Introductory 
Tutorials\Import to Mosaic to Projection\Import.gws, and click Open. 

3. If a GeoMedia error message requests the name of the database file, browse to \Grid 
Analysis Tutorials\Introductory Tutorials\Import to Mosaic to Projection \UrbanArea.mdb, 
click Open, and click OK in the error message box. 

The Map window and its associated legend will open, displaying basic urban features of the City 
of Huntsville. 
 

Importing files 

A Study Area must be defined and active before analysis can take place. When a grid layer is 
imported, a Study Area based on the layer parameters is automatically created and made 
active. 

In this tutorial, six SDTS DEMs and an aerial photograph will be imported. SDTS is the acronym 
for Spatial Data Transfer Standard. This standard defines a non-proprietary format for spatial 
data and associated attributes and metadata. It is intended primarily for spatial data product 
distribution and archiving. 

1. On the Grid tab, in the Study Area panel, click Import. 

2. Select the Import multiple files option. 
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3. To select the files to import, click Browse, navigate to \Grid Analysis Tutorials\Introductory 
Tutorials\Import to Mosaic to Projection, and click OK. 

4. In the Format drop-down list, select USGS SDTS(*catd.ddf). The Available files list will 
now be filled with the list of 30m USGS SDTS located inside the selected folder. 

5. Click the >> button to select all the listed USGS SDTS files. 

6. The aerial photograph file is in a different format. Select GeoMedia Grid (*.mfm) from the 
Format drop-down list 

7. Select the AirPhoto.mfm in the Available files list, and click the > button to add it to the 
Selected files list. 

8. Review the list of Selected files and verify that it matches that shown in the graphic; then 
click Next >. 

9. A dialog box will appear requesting you to supply a Coordinate System File (*.csf) for the 
Airphoto.mfm file. 

Some data file formats do not include coordinate system definition information. In order to 
import these files, a separate GeoMedia Coordinate System File must be supplied. 

10. Click Browse, navigate to C:\Grid Analysis Tutorials\Introductory Tutorials\Import to Mosaic 
to Projection, select the UTM16N NAD83.csf file, and click Open. 

11. Click OK. 

When more than one grid layer is imported at once, the system checks the geographic 
projection and cell resolution of each layer and creates a separate Study Area for each 
unique combination of parameters that it finds. 

12. A dialog appears showing the current read-write connection City of Huntsville. 

13. Expand the list hierarchy. 

14. Inside the City of Huntsville connection are two study areas named by default Study Area 
1 containing the six USGS SDTS layers and Study Area 2 containing the Airphoto layer. 

15. Click Next >. 

16. A final dialog appears showing a report of all the imported layers. 
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17. Click Finish to conclude the import process. 

 
 

Viewing and Displaying Grid Layers 

1. On the Grid tab, in the Study Area panel, click List. The Study Area List window shows 
the connections, Study Areas, and grid layers associated with the GeoWorkspace. 

2. Expand the list hierarchy. 

3. Note that two study areas are listed: Study Area 1, containing all the SDTS DEM layers, 
and Study Area 2, containing the aerial photograph. 

 

Two Study Areas have been created - one for each unique set of parameters. The study 
areas differ in the geographic datums used and in the cell resolution of the grid layers. 

4. Click to select Study Area 2 (the Study Area containing the aerial photograph). The selected 
Study Area becomes active. 

5. On the Grid tab, in the Layer panel, click Display to open the Display in Map Window 
dialog box. 
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6. Make sure that AirPhoto is selected, and click OK. 

7. After a few seconds, the grid layer AirPhoto will appear correctly positioned in the Map 
window. On the Home tab, in the Extent panel, click Fit All to view the entire layer in the 
Map window. Note that AirPhoto has been added to the GeoWorkspace legend. 

 

Display the DEM layers in the Map window using the following steps. 

1. In the Study Area List window, click to select Study Area 1 (the Study Area containing the 
DEMs). This will designate it as the active Study Area. 

2. On the Grid tab, in the Layer panel, click Display to open the Display in Map Window 
dialog box. 

3. Select all six DEM layers. 

4. Click OK. 

 

5. Expand the Map window and move the legend, if necessary, so that the grid layers are not 
obscured. The Map window will appear as in the graphic above. Notice how the DEMs fit 
together with, in some cases, slight seams between the layers. All of the grid layers have 
now been placed in the Map window and are included in the legend. 
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Grid Analysis - Create a Single Mosaic from Multiple Grid 
Layers 

In this section, the Mosaic command will be used to create a single DEM layer comprising all 
the information from the six individual DEM grid layers. This allows analysis of the entire area of 
interest rather than individual tiles. 
 

Using the Mosaic Command 

1. On the Grid tab, in the Layer panel, click Mosaic to open the Mosaic Layers dialog box. 
Note that only layers in the active Study Area are listed in the dialog box. 

2. Select all six DEM layers, and then click the right-arrow button to add the layers to the Grid 
layers to mosaic field. 

3. Check the option Interpolate gaps. The command will interpolate values to "fill" any gaps 
between the layers. 

4. Set Output precision to 1 Meters. 

5. Set Search radius to 5 Cells. Cell values within a radius of 5 cells will be used for 
interpolation. 

6. Select Weighting method: Inverse. The values of cells farther away from a "gap" cell will 
contribute less to the interpolated value than will values of closer cells. 

7. Name the Result layer DEM Mosaic. 

8. Clear the Place results in map window check box. 

 

9. Click OK. There will be no immediately visible result. 
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HINT:  The gaps between the grid layers in this tutorial are small, so a search radius of 5 cells 
is enough to detect and fill them. For data sets with larger gaps, view the gaps in the Edit 
window to estimate their size before deciding on a search radius. The larger the search radius, 
the longer the command will take to execute. 
 

View the Mosaic Result Layer in the Grid Edit Window 

1. On the Grid tab, in the Layer panel, click Edit. 

2. Select the layer DEM Mosaic, and click Edit. This layer will appear in the Edit window. 

3. Use the Zoom-Ratio button  to change the zoom ratio to 2:1. 

4. Use the Query Raster Values tool  to examine the values in the grid layer. There 
should be no apparent seams between the tiles. 

5. Examine the legend. These values represent elevation in meters above sea level. 

 

HINT:  The quality of the DEMs used will determine the number of anomalies and 
edge-matching issues. Grid Analysis commands such as Smooth, Fill Pits, and Fill 
Depressions can be used to address these issues before using the DEM in analysis. 

A color sequence with greater color contrast can make it easier to spot "holes" or abrupt 
transitions in the data. The Grid Edit window will be used to apply such a color sequence to 
"DEM Mosaic." 

1. Click the first legend entry, scroll down the legend, and shift-click the last legend entry to 
select and highlight all the entries. 
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2. Right click on the selected entries to display the context menu, and choose Color 
Sequence. 

3. Use the Color Sequence dialog box to experiment with different combinations of colors and 
color distributions until you arrive at a layer showing some of the inconsistencies in the 
DEM. 

HINT:  The Distribution: Change in zone area option works well for this purpose. 

 

4. Exit the Edit window and do not save. 
 

Defining a New Study Area with a Specified Projection 

When a new Study Area is created, the geographic projection algorithm and geodetic datum that 
have been specified for the GeoWorkspace are applied to the Study Area. 

1. On the Home tab, in the Properties and Information panel, click Coordinate System to 
determine the coordinate system information for the GeoWorkspace. 

2. Click the Projection Space tab. The Projection algorithm should be Lambert Conformal 
Conic (2SP). If it is not, enter that projection algorithm from the drop-down list. 

3. Click the Geographic Space tab. The Geodetic datum should be North American 1983. If 
it is not, enter that geodetic datum from the drop-down list. 

4. Click OK to save the settings and to close the dialog box. 
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Defining a New Study Area 

The new Study Area will be defined to encompass the entire area of the aerial photograph. In 
order to do this, the aerial photograph must be displayed in the Map window. 

1. Right click on AirPhoto in the legend and select Display On. 

2. After a few seconds, the aerial photograph will once again be visible in the Map window. 

3. On the Grid tab, in the Study Area panel, click Define New. 

4. Click and drag the mouse pointer to encompass the aerial photograph. The margins of the 
photo will not exactly match the area you define. If you need to re-do this step, simply press 
Cancel in the Define new study area dialog box and repeat step 3. 

5. Type the Study Area name WorkArea. 

6. Enter 20 Meters as the Cell resolution. 

 

7. Click OK. The new Study Area will be created and will become the active Study Area. 
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Grid Analysis - Reprojecting Grid Layers 

The Reproject/Copy command copies selected grid layer(s) from one Study Area to another, 
reprojecting the layers to the coordinate system and cell resolution of the destination Study 
Area. 

HINT:  Several interpolation methods are available for this command. Lossy near neighbor is 
most suitable for parcel and other filled polygon data. Use Near neighbor for linear features 
such as streams or road networks. Bilinear is useful for most continuous data. Bicubic can also 
be used for continuous data when the results of Bilinear are not satisfactory. 
 

Reprojecting the DEM Mosaic 

1. On the Grid tab, in the Study Area panel, click List.  

2. Select Study Area 1 to ensure that it is the active Study Area. 

3. On the Grid tab, in the Study Area panel, click Reproject to display the Reproject/Copy 
command. 

4. In Grid layers, select DEM Mosaic. 

5. Select Bicubic as the Interpolation method. 

6. Select Data as the Preserve method. 

7. Ensure that City of Huntsville is the Connection. 

8. Select WorkArea as the target Study Area. 

 

9. Click OK. The reprojected grid layer DEM Mosaic now appears in the Study Area List 
under WorkArea. 
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Reprojecting the Aerial Photograph 

1. In the Study Area List window, select Study Area 2 to make it the active Study Area. 

2. On the Grid tab, in the Study Area panel, click Reproject to display the Reproject/Copy 
command. 

3. In Grid layers, select AirPhoto. 

4. Select Bilinear as the Interpolation method. 

5. Select Color as the Preserve method. 

6. Ensure that City of Huntsville is the Connection. 

7. Select WorkArea as the Study Area. 

 

8. Click OK. The reprojected grid layer Airphoto now appears in the Study Area List under 
WorkArea. 

9. Examine the Study Area List. It now contains reprojected versions of both Mosaic DEM 
and AirPhoto under WorkArea. 

The two grid layers in the Study Area WorkArea have been copied from two different study 
areas, with two slightly different sets of parameters. The new, copied layers will now have 
identical parameters. The Layer Information window can be used to verify the cell 
resolution of the two layers. 

10. In the Study Area List window, select WorkArea to make it the active Study Area. 

11. On the Grid tab, in the Layer panel, click Layer > Information. 

12. Select DEM Mosaic and click OK. 

13. Note that the cell resolution of the layer is 20 meters, and then click OK to close the 
Information window. 
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14. Repeat the process to check the cell resolution of the copied AirPhoto grid layer. It also 
should be 20 meters. 

The two grid layers in the WorkArea Study Area now have the same parameters and can 
be used together for subsequent analysis. 

15. To end the tutorial, exit GeoMedia Desktop without saving. 
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